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Introduction

Photomatix Pro works with photographs of the same scene taken under different exposure settings. These
differently exposed images of the same scene are often called “bracketed” images in reference to the auto-
bracketing exposure functions available on many camera models. If you have not taken any bracketed photo
sets, you can start using Photomatix Pro with the sample images available from the download page of the
Photomatix Pro website - http://www.hdrsoft.com. Use the information in Section 1, Taking Photos for
HDR to try Photomatix with your own bracketed images.

Cove Point Lighthouse photo © Ferrell McCollough

This manual contains information about how to use Photomatix Pro to adjust images using different

Tone Mapping or Exposure Fusion methods. All of the methods are accessed from one window within the
application, making it easy to try different settings to achieve the results you want. Refer to Section 2,
Loading and Pre-Processing Images and Section 3, Adjusting Images Using Tone Mapping or Exposure
Fusion for detailed information about the different settings that are available.
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1 Taking Photos for HDR

The shooting phase is essential for getting good results
with Photomatix. To photograph a high contrast scene,
you need to take several exposures in order to capture
information in both the highlights and the shadows of
the scene. The exposures taken must properly cover the
dynamic range of the scene, especially the shadows.

The number of photos you need depends on the scene.
It also depends on the Exposure Value (EV) spacing
separating the photos. If you take them in one-EV steps
(e.g., -1,0, +1 EV), you will need more photos than

if you take them in two-EV steps (e.g., -2, 0, +2 EV).

We recommend shooting in two-EV steps whenever
possible.

High contrast scenes can be grouped into roughly two
types depending on their dynamic range:

+ Medium dynamic range scene: Most landscapes
and other types of outdoor scenes fall into this
category. Three exposures taken in two-EV steps (i.e.
-2,0+2 EV), or five exposures taken in one-EV steps,
are usually sufficient for this type of scene.

+ High dynamic range scene: A typical example is the
interior of a room with a view outside the window on
a sunny day. You need to take at least five exposures
in two-EV steps (or nine exposures in one-EV steps) to
capture this type of scene, but you may need more.
Taking the exposures manually is recommended in
these cases.

Three exposures of a medium dynamic
range scene, taken in two-EV steps

The source photographs for HDR processing can be taken with digital or film-based cameras. The only
requirement is that the exposure can be adjusted when taking pictures. If you use a film-based camera, you
will need to scan the photographs into your computer before processing them (refer to Section 1.3).
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1.1 Setting up the Camera

Exposure comp./AEB setting

« Setyour camera to Aperture priority (the "A" setting) so that

only shutter speed will vary between the exposures.
Darker Brighter
+ Setalow ISO such as ISO 100, or lower if available. B 7.6.5.4.3.2.10.1.2.3.4.5.6%7
pRpugupepEupngegngig
« Turn off the flash. The flash may try to balance the exposure of I]Iisl]mI]

all the images, when the goal instead is a range of exposures.

+ Use a tripod whenever possible. Even though Photomatix Pro

offers automatic alignment of hand-held photos, using a tripod Canon Rebel T2i/550D LCD showing
is almost always better. AEB with +/-2 EV increments selected

DSLR cameras and some compact digital cameras offer Automatic
Exposure Bracketing (AEB). This enables you to automatically
take three or more exposures in a row; one at the proper exposure,
one or more underexposed, and one or more overexposed. Follow
these steps if your camera offers AEB mode:

+ Select the Continuous shooting mode on the camera’s
drive setting. Consult your camera manual for model-specific

. . O i solIN | B H' AdobeRGS G
instructions for using this setting.

T OMmF FSD M @ @ &

+ Set the camera to Auto Exposure Bracketing (AEB) i .
AEB settings on a Nikon D7000

+ If possible, use the camera’s self-timer setting, a cable release or (3 frames, at +/- 2 EV)
a wireless shutter release to minimize camera shake.

+ Set the exposure increment to +/- 2 for optimal exposure range.
If your camera does not offer +/- 2 exposure increments, select

X i The continuous shooting mode may not
the maximum possible. Consult the camera manual for model-  gways be the best strategy because camera

specific instructions for choosing this setting. shake may build up. It is recommended to
use a method that ensures the least possible
1.2 Selecting the Exposures shake for each single shot, such as mirror

lock-up functionality, if available.
To get good results with HDR processing, your bracketed
sequence must include photos that correctly expose highlights as well as
photos that correctly expose shadows. The latter is especially
important to prevent noise-in the processed HDR image.

In the lightest photo of the sequence, the darkest shadow areas of the scene should be shifted at least-

into the mid-tones. To check this, use your camera’s histogram preview in playback mode. In your most
overexposed photo, the left part of the histogram should be empty until 1/3rd of the histogram’s width. If
this is not the case, add one or more photos taken with longer exposure times. Another option is to re-shoot
the exposure sequence with the normal exposure set one or more EVs higher if your most underexposed
image in the exposure sequence was too dark. This is the case when the histogram of your darkest image is
completely empty on the right half.

The number of exposures needed depends on the dynamic range of the scene, in addition to the exposure
increment. For most outdoor scenes, three exposures taken at +/- 2 exposure increments is sufficient,
provided the scene does not include the sun. However, for the interior of a room with a bright view out the
window, you will need at least five images taken with an exposure increment of +/- 2, or nine images taken
with an exposure increment of +/- 1.

In scenes with extreme differences between light and dark details, you should change the exposures
manually to ensure you capture a wide enough range to cover your scene.
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1.3 Using Film-Based Cameras

+ Follow the camera setup listed at the top of Section 1.1 and the tips on selecting exposures in Section
1.2. Keep in mind that you will not have the option of previewing the live histogram to determine your

exposure range.

+ Scan film or slides, not prints. Photo labs attempt to make the best print from each of your source images,
and you will not achieve good results scanning these for HDR generation.

« Turn off your scanner’s auto-exposure options. This allows you to manually control the exposure.

« Make sure you select the Align images option in Photomatix Pro when combining your images.
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2 Loading and Pre-Processing Images

This section describes how to load and merge bracketed
image files of a scene taken under different exposure settings
as well as how to load single images into Photomatix Pro.

2.1 Merging Bracketed Images

Photomatix Pro merges bracketed images that are in 8 bit or
16 bits/channel mode, as well as Camera RAW files.

Supported file types include JPEG, TIFF, PSD, DNG, and RAW
files from many camera models. Photomatix Pro is updated
frequently to add support for RAW files of new camera models.

2.1.1 Loading Bracketed Images

To load bracketed image files, do one of the following:
« Drag and drop the files into Photomatix Pro
«  Use the Workflow Shortcuts panel to load the files

Dragging and Dropping Bracketed Image Files

To drag and drop a group of image files to Photomatix Pro:

+  Windows: Drag the files from Windows Explorer and drop
them on the open Photomatix Pro program.

«  Macintosh: Drag the files from the Finder and drop them
on the Photomatix Pro icon on your Dock.

29 Note

The term “bracketed images” refers to images
of the same scene taken under different
exposure settings. This manual uses the
term “bracketed images” to simplify how these
images are defined. It also applies to the

case when you have not used the Automatic
Exposure Bracketing function of the camera
to take the exposures.

29 Note

rag the image files for the exposure
sequence at the same time, so the files are
properly processed by the merge.

Newer camera models may not be supported
by older versions of Photomatix Pro. To
ensure your camera is supported, upgrade to
the latest version.

If you have Lightroom, you can use the
Lightroom Export Plug-in to load images into
Photomatix Pro.

Refer to Section 5 for more information.
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Using the Workflow Area or the File Menu
To load images using the Workflow Shortcuts panel or the File

menu:

1. Click Load Bracketed Photos in the Workflow Shortcuts panel
OR
Select Load Bracketed Photos from the File menu.

The Loading bracketed photos dialog displays. If you check the Show 32-bit unprocessed
image box, you will be able to save the
unprocessed merged image in an HDR image
file format such as Radiance or OpenEXR.

Select bracketed photos. Saving the 32-bit HDR image is useful
when you want to be able to process the
Click "Browse..." to navigate to your photos image with other tone mapping settings later
or drag-and-drop image files from the Finder. without having to pre-process and merge
your bracketed photos again. However, you
Browse... will still need to pre-process and merge the
venice_normal.jpg = photos if you want to use exposure fusion.
: e
il Remove You will have to click the Tone Map / Fuse
venioe over.Jpd button, in the Workflow Shortcuts window, to
go to the next step if you choose to Show 32-
bit unprocessed image.
| Show 32-bit unprocessed image
( e order of the files in a bracketing
Cancel OH
: E; sequence does not matter.Photomatix Pro

automatically sorts the images based on

Selecting bracketed photos to load the exposure information-in the image files'
EXIF metadata. If exposure information is not

. . available in the EXIF data, Photomatix Pro
2. Drag and drop the files into the Loading bracketed directly evaluates the relative brightness of

photos dialog the photos.
OR

Click Browse. A dialog displays prompting for location of the files.
3. Select the files to load, using one of the following methods:

+ Click the first file, then press and hold the Control key (Windows)
or Command key (Mac). While holding down the Control or
Command key, click each of the other files you wish to select.

+ Click the first file, then press and hold the Shift key. While holding
the Shift key down click the last file. This will select all the files
in-between the first and last file.

4. Click Open (Windows) or Select (Mac).
5. Click OK.

Entering Exposure Values

If the exposure information cannot be located in the metadata of the image files, Photomatix Pro displays a
dialog prompting your input of the relative Exposure Values of the images. Photomatix Pro also displays this
dialog if two or more source images have the same exposure metadata.
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2.1.2 General Merge to HDR Options

After the bracketed images are selected, you can customize the steps performed before merging the images,
such as aligning the images or removing 'ghosts’. Refer to the following list for a description of the options

when merging bracketed images: — ;
8.0.0 Merge to HDR Options

Al |g nment OptionS i Align source images  Crop aligned images

The Align source images option is checked by default. Branontipes

It corrects misalignment problems when the camera &/ hand=held M::::,Z:i:f:cm Gk .
moves slightly between the bracketed frames. Hand- . ' ‘
held photographs have camera movement but even ™ Show options to remove ghosts

images shot on a tripod may have some slight camera

movement as well, such as movement caused by wind,  Reduce noise on [ underexposed image(s) only :
for example. o ook

« taken on tripod: Select this alignment method
when you used a tripod to take automatic bracketed
photos. This method is fast, but corrects only for - a— — — :

. . Checking the 'Reduce Noise' option applies high guality noise reduction to
horizontal and vertical camera movement, and not images in your bracketed set. Note that checking this option
fOf rotation or other types Of motion substantiallyincreases processing time.
(Note: This method was named 'by correcting shifts'
in Photomatix Pro version 4 and earlier.)

« hand-held: Select this method when you did not
use a tripod or when the images are difficult to align. | Align & Show Deghosting |
The 'hand-held' method corrects for several types ' '
of camera movement, including horizontal and
vertical motion, rotation, and forward and backward
movement. When the 'include perspective' option is
selected, it corrects for every kind of minor camera
movement.

(Note: This method was named 'by matching
features' in Photomatix Pro version 4 and earlier.)

Reduce chromatic aberrations

Selecting options to merge to HDR

+ Include perspective correction: This option a : :
The Align source images option should not

requests that the 'hand-held' alignment method be checked when your source images are
corrects for all types of camera movement, including stitched panoramas or when they are "fake
rotation in all three dimensions, as well as horizontal, exposures" derived from a single RAW file.
vertical, forward, and backward motion.

« Crop aligned images: This option removes the unneeded
borders resulting from alignment adjustments. Unchecking it disables this, so that the resulting image
has exactly the same width and height as the source images, but may have white areas around the
edges..

«  Maximum shift: Sets the maximum mis-registration shift that the alignment attempts to correct for,
expressed as a percentage of the image dimensions. This setting does not need adjustment in most
cases. A situation when adjusting this setting may be useful is when the camera barely moved between
the bracketed shots. In this case, setting a maximum shift lower than 12% will restrict the number of
alignment corrections searched, thereby reducing the risk of selecting an improper alignment correction.
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Deghosting Options

Deghosting addresses the problem of artifacts that appear when
combining the bracketed images of a dynamic scene. For iy , — -

; . . . The deghosting option is effective when
example, if the moving subjects are people walking, the people . .

. . . A . . you apply a Tone Mapping method (Details

will appear multiple times in the combined image, once for each Enhancer, Contrast Optimizer, Tone
frame, faded and in a different position as if they were “ghosts”.  Compressor) or the Fusion/Natural method. It
This is why artifacts that arise from movement in a scene are is not effective for the other Exposure Fusion
commonly referred to as “ghosting” and the techniques to methods.
eliminate them are referred to as “deghosting".

#9 Note

Show options to remove ghosts activates the Deghosting Options window, which will open after you
select your merge to HDR options and then click the Align & Show Deghosting button. The Deghosting
Options window provides an adjustable image-wide Automatic Deghosting algorithm and, for more control
over deghosting, a manually applied Selective Deghosting Tool.

Noise Reduction Options

The Reduce noise on option processes source

photos with a high-quality noise reduction (¥ Show options to remove ghosts

algorithm, and is recommended when processing
RAW files directly in Photomatix. Noise reduction ) normal exposure and underexposed

is typically most helpful in dark areas of the source & Reduce noise of ¢ al source images

images, and these dark areas are more prevalent in Strength: —— ) 150%
the underexposed

and, sometimes, in the normally exposed frames. Reduce chromatic aberrations

Noise reduction options
With this in mind, you can use the Reduce noise on

menu to specify that noise reduction be applied only to the darkest images in the bracketed set. Or, if you
wish, noise reduction can be applied to all images in the set.

Strength: Increases or decreases noise reduction strength relative to the automatically determined default
strength value, which is based on the noise level in the image. Values range from 50% to 150%.

Reduce Chromatic Aberrations

The Reduce Chromatic Aberrations option automatically corrects color fringing due to chromatic
aberrations of the lens. Checking this option is recommended, given that chromatic aberrations tend to show
around high contrast edges, and are particularly an issue for HDR images.
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2.1.3 The Deghosting Options Window

Select Show options to remove ghosts in the Preprocessing Options window, to subsequently access the

Deghosting Options window.

[aAA

The Deghosting Options window

The Deghosting Options window provides two deghosting
methods:

+ ASelective Deghosting Tool
+ An adjustable Automatic Deghosting algorithm.

The Selective Deghosting Tool enables you to lasso-select
the specific areas of the image that require processing to
remove ghosting caused by image to image movement

of elements in the scene. Photomatix Pro uses the single
image that it deems-best exposed for the selected area's
brightness, as the default deghosting target image. You
may change the automatically selected deghosting target
image to any other image of your choice, using the tool.

Automatic Deghosting processes the entire image with

an automated ghost reduction algorithm. It is useful

with scenes with many small changes image to image,
which are not practical to manually lasso. This deghosting
method has the disadvantage of potentially degrading
image quality, depending upon the nature of the scene, the
type of ghosting, the number of source frames, and other
factors. When applying Automatic Deghosting, use the
lowest setting that successfully deghosts the image.

N6e

O Selective Deghosting
@ Automatic Deghosting

1. Drag your mouse over the image
to select a ghosted region

2. Control-click (or right-click)
inside the selection to mark it as
ghosted

B Quick selection mode

@ Selective Deghosting
© Automatic Deghosting

Deghosting:
&

None

Base Photo:
Exposure info
F(6.7, 100, 1/750s.

The two alternate Deghosting method panels
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2.1.4 Using the Selective Deghosting Tool

To use the Selective Deghosting tool, click and drag the mouse to draw a lasso around a region that requires
deghosting. Ensure that the dashed line forms a fully closed loop.

Right-click (Windows) or control-click (Mac) inside the selected region and select Mark selection as ghosted
area from the pop-up menu. The line around the selected area changes from dashed to solid, to indicate that
the area is now selected for deghosting. You may make additional deghosting selections, following these
same steps, to mark other image areas for deghosting.

At any time, use the Brightness slider
to increase or decrease the brightness
of the image. Or, use the Zoom slider
to zoom in and out.

If necessary, you can remove a region
from the deghosting selection.
Control click or right click inside an
already marked region and click —ppon
Remove selection from the pop-up '
menu.

election

You may also change the image used
as the deghosting target. Control-click
or right-click inside an already marked
region and click Set another photo
for selection from the pop-up menu.
The tool displays a pop-up menu with
a list of the available exposures. Select A dotted selection being marked for deghosting
an exposure value from the list.

The photo that the tool automatically sets for the selection is not always the most appropriate exposure
choice. It is thus a good idea to check whether changing to another photo produces a better deghosting
result.

g ,r"""r*"" ;
s
i | "‘." £

w1 ""
'.

Mark celectinn ac ahoncted aren
viark selection as ghosted area

Remove selection

Set another photo for selection

. -2 EV photo

-+2 EV photo

e e———r

Right-clicking a marked selection, to choose a different replacement photo
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To view a preview of the deghosted image, click Preview deghosting. To make more selections or modify
existing regions selected for deghosting, click Return to selection mode. You may continue selecting
regions of the image and previewing the results until you are satisfied with the results.

In Quick Selection Mode, every completed selection lasso will automatically be converted into a deghosting
selection, without the need to individually "Mark selection as ghosted area".

2.1.5 Using Automatic Deghosting

The Automatic Deghosting option automatically detects
ghosted areas in the image. The slider sets the 'aggressiveness' Deghosting:
of ghosting detection. ’e

None
A high Deghosting setting removes more ghosting artifacts, but increas-
es the possibility and severity of unwanted artifacts. Try to use a setting

as low as possible, to preserve the quality of the merged HDR image. Base Photo:
Exposure info

F/6.7, 100, 1/750s.

If you need high settings to remove ghosts completely, it is
recommended that you use the Selective Deghosting Tool
instead, if possible.

When automatic deghosting is used, one of the source photos is used
to create the HDR image in areas detected as ghosted. The Base Photo
is the one selected to do this. By default this is the median exposure,
but you can select one of the other photos instead by clicking on its
thumbnail.

After using the Selective Deghosting tool, or applying Automatic
Deghosting, click OK to apply the deghosting adjustments to the image,
or click Cancel to stop merging the images.

If you wish to continue working with the current bracketed set, but with
no deghosting applied, then set the Automatic Deghosting amount to
"0", or make no Selective Deghosting Tool selections, and simply click
OK to proceed.

Automatic Deghosting tools
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2.1.6 Options for RAW Files

Photomatix Pro offers additional options for RAW files.
These options are automatically available when RAW files are loaded.

The White Balance options let you change
the white balance, if desired, and preview the RAW conversion settings
effect of changing it. The default value is "As
Shot", which reads the white balance setting
from the EXIF metadata. To adjust the white
balance, select a pre-defined value from the Eolor primariesibased on:
White Balance drop-down list or type a color
temperature in Kelvin in the text box.

White Balance: As Shot 3

Preview sample...

Adobe RGB 4

Click Preview sample to view the effect of RAW conversion settings, in Merge to HDR Options

the white balance change on the source image.

The Color primaries based on drop-down list provides options for converting the RAW data from the
camera's native color space to the display profile of the selected value. AdobeRGB is the default value and
is appropriate when you want to print the resulting image. If you would like to display the resulting image
only on the web and do not intend to print it, then select sSRGB to avoid having to convert the image from
AdobeRGB to sRGB.

8.0.0 Merge to HDR Dptions

™ Align source images ™ Crop aligned images
taken on tripod

(») hand-held # include perspective correction

Maximum shift: ~ ) . 12%

Show options to remove ghosts

v Reduce noise on | all source images

Strength! — " 150%

¥ Reduce chromatic aberrations

RAW conversion settings
White Balance: As Shot

Preview sample...

Color primaries based on: | Adobe RGB $

Check this option only if your scene includes objects that moved between
the bracketed shots. Otherwise, leave it unchecked, as removing ghosts
lowers the quality of the merged image.

When you check this option, you will see a dialog that lets you adjust the
deghosting options with the help of a preview.

Align & Merge to HDR

Merge to HDR Options window, for RAW files
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2.2 Working with Single Image Files

. A A Do you want to process your image with noise
Photomatix Pro supports Tone Mapping of single ] dtition hefcr:tone m:p;ir:g? ge i et
image files. To load a single image file: _ _
No s
1. Drag the image file to the Photomatix Pro application
(Windows) or icon on your Dock (Mac). Do not ask me again

OR Reducing noise on a single image JPEG file

Select Open from the File menu. A file browser
window displays. Navigate to the file and open it.

OR Tone mapping with the Details Enhancer
. . . . method makes any noise present in the image
Click Load Single Photo in the Workflow Shortcuts window. much more visible, so it is a good idea to

pre-process your image with noise reduction

2. To process the image using Tone Mapping, click Tone before tone mapping.

Mapping from the Workflow Shortcuts panel.

If the file is a JPG, a dialog will show to let you decide whether to reduce the noise on your image before
tone mapping. If desired, check Do not ask me again to skip this dialog and use your Yes or No selection
for all single JPGs that you process with Tone Mapping. If you need to re-enable the dialog later, access
the Photomatix Pro Preferences to change the setting. The Preferences are available from the View menu
(Windows) or Photomatix Pro menu (Mac).

Raw Processing Options

2.2.1 Options for Single RAW Image Files

™ Reduce noise: ————— ——— 100%
When your single image is a RAW file, Photomatix must first Reduce chromatic aberrations
convert the RAW data. The following options are available for
pre-processing the RAW data. White Balance [sAs.Shot s
The Reduce noise option processes the converted RAW PreviewWhite:Balance
file with high-quality noise reduction. It is checked by e AdobeRch .

default as reducing noise is always recommended when
processing RAW files. The Strength slider lets you increase or
decrease the strength of the noise reduction relative to the
automatically determined value based on the noise level in Gl | BB
the image. Values range from 50% to 150%. ' ’

 Enable Exposure Fusion

The Reduce chromatic aberrations option automatically

oo . - RAW Processing Options dialog box
corrects color fringing due to chromatic aberrations of the lens.

The White Balance options let you change the white balance, if desired, and preview the effect of changing it. The
default value is "As Shot’, which reads the white balance setting from the EXIF metadata. To adjust the white balance,
select a pre-defined value from the White Balance drop-down list or type a color temperature in Kelvin in the text box.

Click Preview sample to view the effect of the white balance change on the source image.

The Color Space drop-down list provides options for converting the RAW data from the camera's native
color space to the display profile of the selected value. AdobeRGB is the default value and is appropriate
when you want to print the resulting image. If you do not intend to print the image, select sSRGB for web-only
images to avoid having to convert the image from AdobeRGB to sRGB.

Enable Exposure Fusion allows the image to be processed using the Fusion methods. Normally, Fusion methods are
applicable only to multiple image sets. This option will split the single RAW file into darker and lighter images, which can
then be fused. This allows to use presets belonging to Exposure Fusion methods, such as the 'Natural' preset, for instance.
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3 Adjusting Images Using Tone Mapping or Exposure Fusion

Photomatix Pro provides access to HDR Tone Mapping and
Exposure Fusion methods in one interface, with three main
sections: Adjustments panel, Preview and thumbnail Presets.

This section describes the workflow for adjusting, previewing
and processing images, and describes each Tone Mapping and
Exposure Fusion setting.

3.1 Image Adjustment Workflow

After you have merged your source images (or opened a single image
file), the next steps are:

1. Adjust the image to your liking: Choose a style you like from the
thumbnails listed on the Presets window. You can then refine the
effect by adjusting the controls in the Settings window. Refer to
Sections 3.3 through 3.6 for detailed descriptions of the settings.
Refer to Section 3.2.3 for more information about using presets.

2. Process theimage: When you are satisfied with the adjustments, click
on the Apply button located at the bottom of the Adjustments panel
to apply your settings to the image at its original resolution.

3. Finishing Touch: Once you have processed the image and before
saving it, you may use the options on the Finishing Touch palette in
order to increase the contrast of your image, sharpen it, or adjust the
saturation of individual colors.

4. Savetheimage: When you have processed the image, you can save
it. Select File - > Save As. Navigate to the folder where the file should
be stored. Use the default file name or enter a name in the File name
field. Select a file type:

«  TIFF - 16-bit: the best choice for further processing

«  TIFF - 8-bit: for use in applications that cannot work with 16 bit, or
for avoiding too large a file size on disk

- JPEG: for use on the web without further editing

If you would like to automatically view the file with a photo viewing
application after saving, you can click Open Saved Images with,
in the Save dialog. Accept the default program or select a
program from the drop-down list. If a desired program is not on
the list, click Add application, navigate to the folder containing
the program, select the program and click Open.

Note

posure Fusion is normally only available when
bracketed photos are loaded. When a single
image is loaded, only Tone Mapping is available.

e settings are automatically embedded
in the saved processed image. To view
the settings, click View Settings from the

1 8ne
Process: @ Tone Mapping
@ Exposure Fusion

Method:

Strength

Color Saturation
&
Tone Compression
&
Detail Contrast

&
Lighting Adjustments
&

@ Lighting Effects Mode

bl Hide More Options
Smeoth Highlights

&
White Point

Black Point
[
Gamma
&

Temperature

| 2 Show Advanced Options

Image adjustment settings panel

Workflow Shortcuts bar.

All saved images will now automatically open into the
selected application. To turn off this option, un-click
Open Saved Images with, in the Save dialog.

To undo changes made during
r\ the adjustment process, click
the undo arrow at the bottom of

the adjustments panel.To redo
adjustments, click the redo arrow to
reapply changes.

Photomatix Pro 5.0 User Manual 14



3.1.1 Undoing Adjustments and Reprocessing an Image

After processing an image, you can return to Tone Mapping or Exposure Fusion to continue working with
the same image set. There are two different ways to do this, both accessed from the Workflow Shortcuts
panel; Redo With Other Settings or Double Tone Map.

» Redo With Other Settings allows you to start fresh with the current image set, to apply entirely new
presets and settings.

+ Double Tone Map allows you to add additional effects, using your already-processed image as the
starting point.

Note that you will still be able to use the "Redo With Other Settings" option if you first save the image with

the current settings applied.

Photomatix Pro 5.0 User Manual
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3.2
3.2.1

Image Adjustment Interface

Image Adjustment Interface Overview

The image adjustment interface consists of three main sections; setting Adjustments, image Preview

and Preset thumbnails. The features of these three main interface sections are described in detail below.

3.2.2 Preview

Scaling: 100%

Preview - Lighthouse _normal_over_under

& Preview

@ Selection Mode @

Image adjustment Preview panel controls

The image Preview displays the result of your current settings,
for whichever Tone Mapping of Fusion method you are working

in.

Preview is updated immediately after a setting has been
changed. Preview provides the following controls.

Scaling Slider: Zooms in or out the refreshed preview from
50% to 150%. The preview is not recalculated but quickly

scaled. Each time Fit or one of the Magnifier icons is clicked

the preview is recalculated and the Zoom Slider resets to
100%.

Fit: Resizes the preview to fill the available space on the
program's main window.

Magnifier icons +/-: Increases or decreases the preview
image by 20% and recalculates it at the new size.

Preview: The Preview checkbox quickly toggles between a
preview of the image and the “normal” exposure (OEV) of
the set. This is helpful to compare the effects of the image
adjustments.

Selection Mode: Checking the selection mode checkbox
enables you to select an area of the preview and replace it
with one of the source images. See section 3.7 for details.

Histogram: This floating window contains four selectable
tabs to assist in analysis of the image: Luminance, Red,

Green, and Blue. In addition, move the mouse back and forth
across the histogram to display Level, Count, and Percentile

information. If the histogram is turned off, enable it by
selecting 8-bit Histogram from the View menu.

When using the Details Enhancer or Contrast
Optimizer methods, the Preview is not always
an accurate representation of the final tone
mapped image.

As an option, selectable in Preferences, the
Preview will update continuously as you move
a slider. This option may require that you
work with your image zoomed out to a small
Preview, or that you have a powerful computer
that is able to quickly reprocess the Preview.
This option is not available if you are running
on a 32-bit OS.

You can access application Preferences from the
View menu (PC) or Photomatix Pro menu (Mac).

Histogram - Lighthouse norma...

Red

Green = Blue |

Level: 92 Count: 2522  Percentile: 14.86

8-bit Histogram

Photomatix Pro 5.0 User Manual
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3.2.3 Preset Thumbnails Panel

The Presets panel lists the available presets, showing a thumbnail preview of the effect of the preset on your
image. When you click on a preset thumbnail, the Preview image is refreshed to show the result of applying
the settings of the selected preset.

By default, the panel displays one column of small thumbnails. Click on the “plus”icon on the top of the
panel to display the thumbnails at a larger size. Click on the icon on the top right of the panel to display the
thumbnails in two columns.

There are two types of presets, built-in and custom.

Built-in Presets

Built-in presets are “factory” presets that are provided with the software.
Photomatix Pro offers 36 built-in presets when you are processing hert Lt

bracketed photos, and 27 when you are processing a single file. Anste.

Black & White

The pop-up menu at the top left of the Presets panel lets you view subset
. . . . Details Enhancer
categories of built-in presets. You can display a selected subset of presets Contrast Optimizer

Tone Compressor

from all categories by selecting the “Short List” item. Facion

There are three categories of built-in presets corresponding to effect styles.
They are:
Artistic, Realistic and Black & White.

There are four categories of built-in presets corresponding to processing
methods. They are:
Details Enhancer, Contrast Optimizer, Tone Compressor and Fusion.

Photographic

Natural

Preset panel
Single column, large thumb view

Photomatix Pro 5.0 User Manual
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Custom Presets Al

Custom presets are presets that you saved while adjusting LR
. . rtistic
your images, or presets created by other Photomatix users Realistic
that you have imported. beiabehiiio
Details Enhancer
To access custom presets, click on the My Presets tab located s
at bottom of the Preset Thumbnails panel. To create your Fusion

own custom presets, refer to the Saving Custom Presets
paragraph below. You can also import custom presets
created by other Photomatix users that you downloaded to
your computer as XMP files. To import the presets, select the
item “Import Presets...” on the pop-up menu on the top left
of the Preset Thumbnails panel, and browse to the location
on your computer where you downloaded the XMP preset

files.

Saving Custom Presets

There are two ways to save custom presets as an XMP file for
future use; during the image adjustment phase or after Tone
Mapping or Exposure Fusion is complete.

To save custom presets during image adjustment:
1. In the Adjustments panel, click the Presets drop-
down list.
Select Save Preset from the list.
3. Enter a name for the preset in the File name field and
click Save.

To save the processing selections as a preset after Tone
Mapping or Exposure Fusion processing:

1. Click Save Preset from the Workflow Shortcuts panel
or select Save Preset from the File menu.
A dialog prompts for the file name.

2. Enter the file name and click OK.

Built-In.

Artistic built-in Presets
Two column, small thumb view

%9 Note

If you save the preset in the default location
(which is the Presets folder of the Photomatix
Pro application), the preset is automatically
added to the Presets combo-box list, and also
shows on the “My Presets” tab of the Preset
Thumbnails Panel.
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3.3 Tone Mapping Details Enhancer Settings
General Settings

Strength: Affects the amount of enhancement given to contrast
and detail in the image. A value of 100 gives the greatest
enhancement. Moving the slider to the left gives a more natural
effect. The default value is 70.

Saturation: Adjusts the color saturation of the image. The
greater the saturation, the more intense the color. Setting the
slider to its lowest value (0) produces a grayscale image.

The default value is 46.

Strength

Color Saturation
[}
Tone Compression

Detail Contrast

Details Enhancer - General settings

Tone Compression: Adjusts the dynamic range of the tone mapped image. Moving the slider to the right
decreases the dynamic range, brightening the shadows and darkening the highlights. Moving to the left

has the opposite effect, giving a more 'natural’ look.
(This setting was named 'Luminosity' in older Photomatix versions.)

Detail Contrast: Controls the amount of contrast applied to detail in the image. Moving the slider to the
right increases the contrast of details and gives a sharper look to the image, but also has a darkening
effect. Moving to the left decreases the contrast of details and brightens the image.

Lighting Adjustments pane: The two lighting adjustment modes
affect the overall 'look], controlling the extent to which the image
looks natural or surreal.

Lighting Adjustments slider: Affects the overall 'look; controlling
the extent to which the image looks natural or surreal. Moving the
slider to the right makes the image look more natural. Moving to the
left makes it look more 'painterly’ or surreal.

Lighting Effects Mode checkbox: Lighting Effects Mode lets you
switch between two modes for the Lighting Adjustments setting,
where each mode produces slightly different results. Checking the
box tends to produce results with a type of 'Magic Light' effect. Note
that finer control is not possible in this mode.

Lighting Effects Mode: Affects the overall 'look, controlling the
extent to which the image looks natural or surreal.

More Options

Smooth Highlights: Reduces contrast enhancements in the
highlights, preventing white highlights from turning grey, or
preserving a uniform blue sky. It is also useful for reducing halos
around objects placed against bright backgrounds.

White Point: Sets the maximum value of the tone mapped image.
Moving the slider to the right sets a lower maximum value, which
brightens the image and increases global contrast. Moving to the
left sets a higher maximum value, which decreases global contrast
and reduces highlights clipping.

The default value is 0.25%.

Black Point: Sets the minimum value of the tone mapped image.
Moving the slider to the right increases global contrast. Moving
to the left sets a lower minimum value, which decreases global
contrast and reduces shadows clipping.

Photomatix Pro 5.0 User Manual

Lighting Adjustments
&

@ Lighting Effects Mode

Details Enhancer -
Lighting Adjustment settings

Lighting Adjustments

o

Details Enhancer -
Lighting Effects Mode

T Lighting Effects

Smooth Highlights

&

White Point
Y

Black Point

[ Y

Gamma

Temperature

Details Enhancer - More Options

19



Gamma: Adjusts the brightness of the midtones, which also has an impact on the overall contrast.
Moving the slider to the right brightens the midtones and decreases the contrast. Moving to the left
darkens the midtones and increases the contrast. The default value is 1.0.

Temperature: Adjusts the color temperature of the tone mapped image relative to the temperature of the
HDR source image. Moving the slider to the right gives a 'warmer, more yellow-orange colored look. Moving
it to the left gives a 'colder' more bluish look. A value of 0 (default) preserves the original color temperature
of the HDR source image.

Advanced Options %9 Important Note
+  Micro-smoothing: Smoothes out the enhancement of The Loupe may not properly show the effect of
small details, which has the effect of reducing noise in the the M,gg-;mo?hmg;ettmg Whtetn the a;Lea
. . . . magnified is uniform. If you want to see the
:I(:Zufltir instance, and tends to give a 'cleaner’ look to the effect of the Micro-smoothing setting at 100%

resolution on a uniform area such as the sky,
Saturation Highlights: Adjusts the color saturation of the you will have to select an area that contains an

highlights relative to the color saturation set with the Color ~ object in the scene in addition to the sky.
Saturation slider. Values higher than 0 increase the color

saturation in the highlights. Values lower than 0 decrease it.

The default value is 0.

Saturation Shadows: Adjusts the color saturation of the shadows relative to
the color saturation set with the Color Saturation slider. Values higher than zero
increase the color saturation in the shadows. Values lower than zero decrease it.
The default value is 0.

Shadows Smoothness: Reduces contrast enhancements in the Vicioneroothing

shadows. h

Shadows Clipping: The value sets how much of the shadows range Saturation Highlights
is clipped. This control may be useful to cut out noise in the dark &
area of a photo taken in a low-light situation. Saturation Shadows
360° image: Checking this option eliminates the seam between - &
the left and right sides of a panorama viewed in a 360 degree Shadows Smoothness
panoramic viewer. This option is intended for a stitched panorama - &

it should not be used for individual frames of a panorama that have Shadows Clipping
not yet been stitched. &

@ 360° image

Details Enhancer - Advanced Options

Photomatix Pro 5.0 User Manual 20



3.4 Tone Mapping Contrast Optimizer Settings

«  Strength: Affects the amount of enhancement given to contrast and detail
in the image. A value of 100 gives the greatest enhancement.
Moving the slider to the left gives a more natural effect. The Tone Compression
default value is 50.

Lighting Effect

«  Tone Compression: Alters the dynamic range of the tone mapped
image. Moving the slider to the right decreases the dynamic
range, brightening the shadows and darkening the highlights.

Moving to the left has the opposite effect, giving a more 'natural’ nhietle é
look to the image. '
Black Clip
+ Lighting Effect: Controls the prominence of the shadows, a.
affecting the overall look of the image. Moving the slider to the \iekohe
right brightens the shadows, giving a more 'vibrant' or a

surreal look. A value of zero disables the effect, leaving the

Color Saturation
shadows unaffected. The default value is 20.

«  White Clip: Adjusts the amount of highlights clipping. Moving Color Temperature
the slider to the right brightens the image and increases global rs
contrast. Moving to the left decreases global contrast and reduces
highlights clipping. @ 360° image

«  Black Clip: Adjusts the amount of shadows clipping. Moving the Contrast Optimizer Settings
slider to the right darkens the image and increases global contrast.
Moving to the left decreases global contrast and reduces shadows
clipping.

«  Midtone: Adjusts the brightness of the midtones, which also has an impact
on the overall contrast. Moving the slider to the right brightens the midtones
and decreases contrast. Moving to the left darkens the midtones and
increases contrast.

- Color Saturation: Adjusts the color saturation of the image. The greater the
saturation, the more intense the color. Setting the slider to its lowest value
(-10) produces a grayscale image.

« Color Temperature: Adjusts the color temperature of the tone mapped
image relative to the temperature of the HDR source image. Moving the slider
to the right gives a 'warmer, more yellow-orange colored look. Moving it to
the left gives a 'colder' more bluish look. A value of 0 (default) preserves the
original color temperature of the HDR source image.

«  360° Image: Checking this option eliminates the seam between the left
and right sides of a panorama viewed in a 360 degree panoramic viewer.
This option is intended for a stitched panorama - it should not be used for
individual frames of a panorama that have not yet been stitched.
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3.5 Tone Mapping Tone Compressor Settings

Brightness: Adjusts the overall brightness of the image.

Tonal Range Compression: Controls the compression of the tonal
range. Moving the slider to the right has the effect of shifting both
shadows and highlights toward the midtones.

Contrast Adaptation: Adjusts the contrast in relation to the
average brightness. Moving the slider to the right tends to
decrease contrast and give more 'pronounced' colors. Moving to
the left tends to increase contrast and give a more 'natural’ look.

White Clip: Adjusts the amount of highlights clipping. Moving
the slider to the right brightens the image and increases global
contrast. Moving to the left decreases global contrast and reduces
highlights clipping.

Black Clip: Adjusts the amount of shadows clipping. Moving the
slider to the right darkens the image and increases global contrast.
Moving to the left decreases global contrast and reduces shadows

clipping.

Color Saturation: Adjusts the color saturation of the image. The
greater the saturation, the more intense the color. Setting the slider
to its lowest value (-10) produces a grayscale image.

Color Temperature: Adjusts the color temperature of the tone
mapped image relative to the temperature of the HDR source
image. Move the slider to the right for a warmer, more yellow-
orange colored look. Move it to the left for a colder, more bluish
look. A value of 0 (default) preserves the original color temperature
of the HDR source image.

Photomatix Pro 5.0 User Manual
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3.6

Fusion Settings

3.6.1 Fusion/Natural Settings

Strength: Sets by how much local contrast is accentuated. Moving
the slider to the right tends to brighten the shadows and to show
more details in the highlights. Moving to the left produces a more
'natural’ effect.

Brightness: Controls the brightness of the fused image by
adjusting the influence each of the input photos has on the final
result. Moving the slider to the right gives the overexposed photos
more influence, resulting in a brighter result. Moving to the left
darkens the result by giving the underexposed photos more
influence.

Local Contrast: Increases the contrast and sharpness of details in
the image. Increasing local contrast may have the side effect of
making noise more visible and of creating thin halo effects around
strong luminosity edges. Values near the maximum tend to give a
surreal look to the image. The default value is 2.

White Clip: Adjusts the amount of highlights clipping. Moving
the slider to the right brightens the image and increases global
contrast. Moving to the left decreases global contrast and reduces
highlights clipping.

Black Clip: Adjusts the amount of shadows clipping. Moving the
slider to the right darkens the image and increases global contrast.
Moving to the left decreases global contrast and reduces shadows

clipping.

Midtone: Adjusts the brightness of the midtones, which also has
an impact on the overall contrast. Moving the slider to the right
brightens the midtones and decreases contrast. Moving to the left
darkens the midtones and increases contrast.

Color Saturation: Adjusts the color saturation of the image. The
greater the saturation, the more intense the color. Setting the
slider to its lowest value (-10) produces a grayscale image.

360° Image: Checking this option eliminates the seam between
the left and right sides of a panorama viewed in a 360 degree
panoramic viewer. This option is intended for a stitched panorama
- it should not be used for individual frames of a panorama that
have not yet been stitched.
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3.6.2 Fusion/Real-Estate Settings

Highlights: Adjusts bright areas in the image. Moving the slider
to the right brightens the highlights. Moving to the left darkens
highlights and recovers more highlight details.

Shadows: Adjusts dark areas in the image. Moving the slider to
the right brightens shadows and recovers more shadows details.
Moving to the left darkens shadows.

Local Contrast: Increases the contrast and sharpness of details

in the image. Increasing local contrast may have the side effect of
making noise more visible and of creating thin halo effects around
strong luminosity edges. Values near the maximum tend to give a
surreal look to the image. The default value is 2.

Color Saturation: Adjusts the color saturation of the image. The
greater the saturation, the more intense the color. Setting the
slider to its lowest value (-10) produces a grayscale image.

Highlights Depth: Affects the colors of the highlights in the
image. Moving the slider to the right adds depth to the highlights,
darkening the highlights and increasing their colorfullness

360° Image: Checking this option eliminates the seam between
the left and right sides of a panorama viewed in a 360 degree
panoramic viewer. This option is intended for a stitched panorama
- it should not be used for individual frames of a panorama that
have not yet been stitched.
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3.6.3 Fusion/Intensive Settings

«  Strength: Adjusts the strength of local contrast enhancements.

« Color Saturation: Adjusts the color saturation of the image. The

Strength

greater the saturation, the more intense the color. Setting the slider to [EFGN SR

its lowest value (-10) produces a grayscale image.

« Radius: Controls the area used to calculate the weighting of
the source images. A higher radius reduces halos, but increases
processing times significantly. The default value is 70.

3.6.4 Fusion/Average, /Auto, /2 Images Settings

There are no setting options for the Fusion/Average or Fusion/Auto methods.

The Fusion/2 Images method allows you to choose to fuse any
combination of two images from among the loaded bracketed set.
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3.7 Replace Selection with Source

An HDR-processed image might look exactly the way you want, except for one area. For example, the sky
might have more contrast or be darker than desired. The “Replace selection with source” feature lets you
replace that area with the same area from any one of the source images, to bring the tonemapped or fused
image closer to what you want.

3.7.1 Selecting the Area to be Replaced

To enable this feature, click the Selection Mode checkbox.
The Polygonal Lasso is the default tool. £ Swction Wodw o

We recommend using the Polygonal tool, but you can use the
Normal or Magnetic tool if you prefer. Selection works differently,
depending on the tool.

Selection Mode checkbox

+ Polygonal lasso
- Click to set the selection line’s starting point.

- Move the mouse and click to create a straight segment, attached to the previous point.
Repeat to create additional segments.

- To close the selection, double-click, or single-click on the starting point.

« Normal lasso
- Click and drag the mouse to draw a freehand selection.
- Release the mouse button to close the selection.

+ Magnetic lasso

- Click and drag the mouse as with the Normal lasso. If an edge is within the Width setting, the selection
path snaps to the edge.

- To close the selection, double-click, or single-click on the starting point.

Choosing a Lasso

— The Polygonal lasso is ideal for areas with straight sides, and good for large areas (because you don’t have
to hold down the mouse button).

- The Normal lasso is good for areas with curved sides. It's not the best choice for large areas, because you
have to hold down the mouse button as you drag.

 Selection Mode (7]
B Attach to Edges ETFPEE Contrast: [T

Sealing: 00 - + & Preview

A selection drawn with the polygonal lasso
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3.7.2 Fitting the Selection to the Area’s Edges

The area to be replaced usually has at least one irregular border (such as the mountains in this sample
photograph). It’s difficult to draw irregular borders exactly, and you don’t have to. You can draw approximate
borders, and Photomatix will fit them for you by "finding the edges"

Finding the edges

The borders of the area you want to replace are almost always U Selection Mode (7Y

at edges — large changes in brightness between adjacent (U Attach to Edges Contrast: (TR
pixels. In the sample photo, the transition between the light
sky and the darker mountains is an edge. Attach to Edges checkbox

Selecting the Attach to Edges checkbox causes Photomatix to search for an edge near the selection path you
drew. The selection path is then redrawn along the edge — in this case, the mountains.

[ Selection Mode (7]
[ Attach to Edges ETFTEED Contrast: [T

Scaling: 0% - + & Preview

Polygonal selection after clicking "Attach to Edges"

The Contrast setting (Low, Medium, High) determines whether a difference in brightness is large enough to
be detected as an edge. The higher the setting, the greater the brightness difference has to be.

The Width box (next to the Attach to Edges box) sets the maximum distance Photomatix searches (in pixels)
from the original selection path. If Photomatix finds an edge within the Width setting, the selection is
redrawn to fit the edge. If Photomatix finds a border of the image, the selection is redrawn along the border.

Changing the Width or Contrast setting immediately redraws the selection path to reflect the new value.

To undo the edge fit, clear the Attach to Edges checkbox.
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3.7.3 Replacing the Selected Area

Right-click (Windows) or control-click (Macintosh) anywhere within the selection. A contextual menu
appears.

- If you loaded bracketed photos, the menu identifies them by their exposure difference, relative to the
“normal” exposure. Click the photo at the EV you want.
- If you loaded a single image, click "Replace with source”.

Replace with photo at EV -2
Replace with photo at EV 0
Replace with photo at EV + 2

Remove selection

Replacing the selected afea
If you prefer not to see the lines marking your selection, uncheck the Selection Mode checkbox.

To discard the replacement and return to the initial preview, right-click within the selection and select the
checkmarked item in the contextual menu.

v Replace with photo at EV -2
Replace with photo at EV 0
Replace with photo at EV + 2

Remove selection

Returning to the initial preview

Photomatix Pro 5.0 User Manual
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4 Automating with Batch Processing

Use batch processing to automatically process image files. The batch processing tool saves time processing
many images. Photomatix Pro offers two different batch modes:

- Batch Bracketed Photos: Processes bracketed sets using HDR Tone Mapping and/or Exposure Fusion all
in one step, which can save you a lot of time when you have many bracketed sets to process.

« Batch Single Photos: Processes multiple single image files using Tone Mapping.

4.1 Batch Processing Bracketed Photos

This section describes batch processing of bracketed photo sets, taken under multiple exposure settings.

0.6.0

Batch Processing of Bracketed Photos

HDR SETTINGS

Use: (s) Preset | Painterly

Custom settings or multiple presets

 Align images

W Crop aligned images

taken on tripod (s hand-held

Remove ghosts

™ Reduce noise

Create 32-bit unprocessed merged file

More Preprocessing Options...

(*)Process | 3 3| images at a time

Advanced selection  Option

SOURCE

Select Source Folder...

IMG_9572.CR2
IMG_9573.CR2
IMG_9574.CR2
IMG_9622.CR2
IMG_9623.CR2
MG, GR24 CR?

Remove from list

T

Select: (=) Folder

Filver by | Al

Process subfolders  sequentially

4.1.1 Using Batch Processing

Batch will merge 3 files at a time,
from the Source list below.

Close | Run

DESTINATION

(#) Created in Source Folder
Custom Location Choose Location...

Save processed image as  TIFF 16-bit

Save intermediary 32-bit HDR file as = Radlance RGEE (hdr)

Maming & Output Options...

Batch Processing of bracketed photos

To batch process multiple sets of bracketed photos follow these steps.

1. Open the Batch Processing of Bracketed Photos window by:

Clicking the Batch Bracketed Photos button in the Workflow Shortcuts panel

OR
Using the 3B keyboard shortcut
OR

Selecting Batch Bracketed Photos from the Automate

menu.

2. Select a preset from the Use: Preset menu.
This preset will be applied to all the bracketed sets in this batch.

%7 Note

The Custom settings or multiple presets
window allows you to process multiple
bracketed sets with multiple presets.

This more advanced batch option is explained
in section 4.1.3 below
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3. Configure basic preprocessing options, to specify alignment,

ghost removal, noise reduction, and whether to create and \’
save an unprocessed 32-bit merged file. The .More Preprocessing Options... putton
provides access to deeper preprocessing
4. Select the number of exposures to combine using the pull-  settings.

down menu below the checkboxes. For example, select “3” if
your bracketed sets consist of three exposures each.

5. Inthe Source area, select the folder where the bracketed photo sets are located. The files are arranged in
alphabetical order. "N" files at a time are processed with "N" being the number specified in the previous
step.

6. To save the results in a different folder than the folder containing the source photos, select Custom
location option in the Destination frame at the bottom right of the window, and then click Choose
Location... to specify where to save the processed images.

OR

Accept the default of Created under source folder to create a subfolder with the name
PhotomatixResults in the source image folder.

7. Inthe Destination pane, select the output file type. When using JPG file output, select the amount of
JPEG compression. 100 gives the least compressed JPEG file, with most image quality retained.

8. Click Naming and Output Options if you would like to rename, resize, add contrast or sharpen the saved
images.

9. Click Run to start batch processing.

While the batch is running, the processing status will display in the area below the Run button. When
processing is complete, a link to the batch results will be displayed

4.1.2 Custom Settings or Multiple Presets window

The Custom Settings or Multiple Presets
window is accessed by clicking the Set... button ST praneil. Deafault . e T

at the top of the batch processing window.
(#) Custom settings or multiple presets Set...

This window allows you to compile a list of
multiple built-in presets and/or custom settings, Click "Set..." to set up preset batches
to be applied to a single bracketed image set or to a
batch of bracketed image sets. This feature may be
thought of as "Preset batches". The presets batch

K ) . . . . Preset:  Default : Add
lists compiled in this window are applied to the e :

image set batches which are specified in the Source

frame Of the main batch WindOW. Custom Settings: Details Enhancer = Set...

Preset batches applied to bracketed sets provides a

Settings Type Preset/Settings Name
wide range of processing options. You may wish in Updatez
some instances to work with just a single bracketed ol s e a Remove

; uilt-in Preset Painterly

set, and apply a batch of 20 or 30 different presets to Built-in Preset  Painterly 2
. . . H User Preset Fusion/Natural Custom Settings 01
it allowing you to cgnvenlently test \{vhlch presets sl it kibaia G S b1 Clear List
give the most pleasing results for a given image set. Built-in Preset  Natural

Built-in Preset Creative
Another strategy is to apply several different

oK |

favorite presets to multiple image sets. Be aware,
while exploring this tool, that the batch results can Save custom settings in XMP file

become very large. Custom Settings or Multiple Presets window
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For example, 30 Presets applied to 30 bracketed sets will output 900 processed images. Plan ahead for the
processing time and the disk space required when combining large preset batches with large image set batches.

To set up a batch of existing presets, follow these steps:

1. Select a Built-in preset, or one of your own saved presets,
from the Preset menu and then click Add. This preset will
appear in the list frame.

2. Repeat step 1 as many times as you like, to add additional presets to the list.
If you wish to remove a preset from the list frame, select it and click Remove.

4. You may now click OK to close this window.
The specified presets will be applied the next time a batch is run.

To set up a batch of modified presets or new custom settings, follow these steps:

1. Select a method from the Custom Settings menu, and then click Set...
The Settings Adjustments window for the selected method will open.

2. Select a method preset from the Presets: menu, and modify as desired.
OR
Modify the existing settings. The existing settings are the default for that method.

Click OK. The new custom setting will be added to the list frame.
Repeat steps 1, 2 and 3 as many times as you like, to add additional custom settings to the list.
If you wish to update a previously added custom setting, select it in the list frame, and click Update...

If you wish to remove a custom setting from the list frame, select it and click Remove.

N o oun s ow

You may now click OK to close this window.
Image Alignment Advanced Settings:

The specified presets will be applied the next time a batch is run.

J Include perspective correction

Maximum shift: - 12%

4.1.3 More Preprocessing Options =
Ghost Removal Advanced Setting:

Deghosting: 50

Medium

Use the More Preprocessing Options... button to access more
advanced settings, some of which provide deeper control over the
basic preprocessing settings available in the main batch window.

Noise Reduction Advanced Settings:

Reduce noise on: | underexposed image(s) only

Strength: - 100%

4.1.4 32-bit HDR File Creation Advanced Settings

Force Exposure Values spacing to: Forces the EV spacing to

Other Preprocessing Setting:

the specified value. This option can be used when the exposure
information is not available in the EXIF data, if two or more images
have the same exposure information, or to force the EV spacing in
all cases. In the latter case, the exposure information in the EXIF
datais ignored.

Please refer to sections 2.1.2 and 2.1.6 above for a description of
the other preprocessing settings.

Photomatix Pro 5.0 User Manual

qf Reduce Chromatic Aberrations

32-bit HDR Flle Creation Advanced Settings:

Force Exposure Values spacing to: 2
* When exposure information not found in EXIF data

In all cases

RAW Conversion Settings:

White Balance: | As Shot
Preview Sample...

Color primaries based on: Adobe RGB

OK

More Preprocessing Options window
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4.1.5 Batch Processing Subfolders
29 Note

When your bracketed series are located in multiple folders, they
can all be processed in one run, provided they are in subfolders = . . —
of the same parent folder. To batch process multiple subfolders, A\l ©f the subfolders must be contained in

. the main parent folder for this option to work
check the Process subfolders option at bottom of the Source

X . A properly.

frame on the Batch Processing dialog and select sequentially.
When “Process subfolders sequentially”is selected, the batch will process the bracketed image files in one
subfolder and then move on to the next subfolder, all of which are contained in the main parent folder.

Processing Series of Photos with Varying Numbers of Exposures

When your bracketed sets are composed of varying numbers of exposures, you can use “Process subfolders
sequentially” to combine the exposures in these sets in one batch run. Place each set in a separate subfolder,
group the subfolders under a parent folder, select Process subfolders sequentially and select All from the
pull-down menu for the number of images to process at one time.

Grouped by Exposures Option

If you are processing bracketed photos that will be part of a panorama, you may find it useful to be able to
organize your photos in such a way that all exposures of the same levels are in the same folder. Let’s take as
an example a panorama composed of four views that need to be stitched, with each view having been taken
under three exposures: -2, 0, +2. You will then have 12 photos, and may need to place them in three separate
subfolders composed of four photos each as follows:

«  Subfolder1 contains the four photos for the panorama taken at EV -2
«  Subfolder2 contains the four photos for the panorama taken at EV 0
«  Subfolder3 contains the four photos for the panorama taken at EV +2

If you check “Process subfolders” and select “grouped by exposures’, the batch will combine the first file

of Subfolder1 with the first file of Subfolder2 and the first file of Subfolder3. The batch will then combine the
second file of Subfolder1 with the second file of Subfolder2 and the second file of Subfolder3, and so on for the
third

and fourth file of each subfolder.

= Automatically detect number of bracketed frames:

4.1.6 Advanced Selection Options

Bracketed sets have between 3: and 3 ;| frames
The following items are accessed from the Process frame TR SOy Ine an even number of frames
when you click Advanced and click Options to configure Maximum time between two successive bracketed frames:

2 seconds

automatic selection of bracketed image files.

Click Automatically detect the number of bracketed
frames when processing a folder that contains files in Bracketed sets have 5 : frames each, but only process
addition to those in the set of bracketed frames or when the frames selected below:

the number of frames in the set varies. Photomatix Pro uses '

Select anly some of the frames in bracketed set:

. . first fi
the metadata from the image files to perform automatic i esie
bracketed set detection. third frame
fourth frame
«  Specify a range using the two drop-down lists to st frame
aUtomatica"y deteCt the number Of braCketed frames' This option is useful when some of the photos in the processed folder
. Move the Maximum time between tWO successive :\,n: nkat p:rlo{a bracketed set and/or when the number of frames per
racketed set varies.
frames Slldel’ r|ght or Ieft tO a||OW more or IeSS time (read Naote that the automatic detection is based on the metadata infermation
. . of the image files and not on the image content. It can therefore only
from the metadata). If your camera is set on continuous work with photos shot under different exposure settings ~such as Auto
o Exposure Bracketed photos- with their EXIF data preserved.
shooting and takes 3 frames/second, for example, then
the slider could safely be set on 1 second. —

Advanced batch processing options
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Click Select only part of the frames in bracketed set to load only selected frames from a bracketed set.

«  Specify the total number of frames in each set using the drop-down list.
+  Select the specific frames to process from the list. Select more than one file by holding down the Control
key (Windows) or Command key (Mac) and clicking on the desired frames.

8.68.0

Batch Tone Mapping af Single Photos

4.2 Batch Processing Single Images Sos

S_gl_et_:l Fal_der...

To process a batch of single image files:

JUsers/itunes/Windows 7 5...g test files [GoldenCate_Raw

| GoldenGate35.CR2
| GoldenGate36.CR2
GoldenGate37.CR2

1. Open the Batch Tone Mapping of Single T on sk N e proski. (A e it B GoldenCiate38.CR2
. (IF wou rather wish to tone map one photo with a preview 1o adjust |
Photos W|ndOW by: the settings, close this window and open the phata via File > Open) |
Click the Batch Single Photos button in the Processing Options
Workﬂow Shortcuts panel Use: (s Preset Default 3 fer | Al
OR Custom Settings for Details Enhancer N Sat...
. ¥ Reduce noise before tone mapping  ————— " 100%
Select Batch Single Photos from the Automate
Reduce chromatic aberrations before tone mapping
menu. With RAW files, set White Balance to | As Shot : | ColorSpaceto  Adobe RGE
2. To select the source folder that contains the files, Remove ‘Photomatix’ watermark from images created when Photomatix Pro was in trial mode
click Select Folder, and Navigate to the folder Destination
that Contains the ﬁles and C“Ck OK (s Created under Source Folder Customized location Choose...
The folder path and the files in the folder will be
displayed. Save tone mapped image as  JPEG B JPEG Quality: 100 .
Append suffix:

3. Optionally, you may select a subset of the
displayed files to process:
Hold the Control key (Windows) or Command
key (Mac), and click to specify files for processing.

4. To process the selected files using an existing
preset, select a preset from the Use: Preset menu.
To Process the selected files using a new

custom setting, select a method from the Use:

Save custom settings in XMP file

Cancel Run- |

Batch Tone Mapping of Single Photos

Custom Settings for menu, then click Set..., and then configure the preset as desired.

5. Click the checkboxes for noise reduction and CA correction, if needed.

6. To select a destination folder, click Created under Source Folder

to save the images in the same folder as the source files.

OR

Click Customized Location to save the images in a
different folder.

Click Choose to select the destination folder.

The folder path will be displayed.

7. Select the output file type. When using JPG file output,
select the amount of JPEG compression. 100 gives the least
compressed JPEG file, with most image quality retained.

8. Click Run. The batch processing status displays.

When batch processing is complete, a link to the batch results
will be displayed.
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29 Note

The Batch Single Photos feature is intended
for automating the processing of a lot of
photos. To process a single image file, load the
image file using the information in Section 2.2.

29 Note

remove the watermark, Photomatix Pro
requires that the image was not retouched after
the watermark was added to it. If the brightness
or contrast of the image was changed, or the
image was double tone mapped, or cropped

or resized, then Photomatix will not be able to
remove the watermark.
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5 Tips and Techniques

This section provides tips for working with images in Photomatix
Pro. More tips and techniques, and regularly updated information,
can be found on the Photomatix Pro FAQ on the HDRsoft website at
http://www.hdrsoft.com/support/faq_photomatix.html.

5.1 Integrating Lightroom and Photomatix Pro

You can export photos for processing in Photomatix Pro directly
from Lightroom and reimport them back into the Lightroom library.

The Lightroom Export to Photomatix plug-in is free and included
with the Photomatix Pro package. Please refer to the HDRsoft
website at http://www.hdrsoft.com/download/Irplugin.html for
installation instructions and a short tutorial showing how to use the
Lightroom export plug-in for HDR processing in Photomatix Pro.

5.2 Processing RAW files in Third-Party RAW Converters
When using a third-party RAW converter, develop the RAW images with the following settings.

As an example, the screenshots show the settings in Lightroom:

Color Black & White

As Shot

Basic Settings in Lightroom

- White Balance: Use the same white balance for all source photos.

Highlights
Lights
Darks

Region

Linear

Working with curves in Lightroom

« Basic settings: Set all to zero. It is particularly important to set the Blacks setting to zero.

«  Curves: Parametric and Point Curves should be linear.

+ Details: Set the Sharpening Amount to zero

Photomatix Pro 5.0 User Manual
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5.3 Dealing with Noise

When you process your photos using Exposure Fusion, the fused image will tend to show less noise than the
source images. This is because Exposure Fusion works by directly combining your bracketed photos, thus
averaging out noise. However, when you create a 32-bit HDR image, your bracketed photos are assembled
in linear space into an image that spans the full range of luminance values captured by the camera. If the
lightest photo of your exposure sequence is not bright enough to expose the shadows of the scene, then
the noise in the source photographs will be transferred to the HDR image. Noise in the HDR image will then
be made more apparent by tone mapping, especially with Details Enhancer as this tone mapping method
increases local details.

Though Photomatix Pro includes options to reduce noise, it is still always better to avoid noise at capture
time as much as possible. There are two tips to ensure a low noise level:

« Tip 1:Seta low ISO setting (ISO 100 or lower) whenever possible

« Tip 2: Overexpose sufficiently, ensuring that the lightest image of your exposure sequence has its
shadows in the mid-tones.

5.4 Photomatix Pro and Color Management

Photomatix Pro supports color management even if RAW files are processed. You should use the same
working space in Photomatix Pro as you use in other image editors (e.g. Photoshop).

Photomatix supports the three most popular working spaces:

+  sRGB: Use if the images are created only for the web.

« Adobe RGB: Popular working space for printing if extremely saturated colors are not used.
+  ProPhoto RGB: Wide gamut working space. This should never be used for 8-bit images.

For all JPEG and TIFF files, Photomatix Pro preserves the color spaces of the source files.

Photomatix Pro 5.0 User Manual

35



Glossary

AEB Mode

Aperture Priority

Bit
Bit Depth
Bracketed images

Chromatic Aberration

Contrast Ratio

dSLR

Dynamic Range
EXIF

Exposure

Exposure Fusion

EV (Exposure Value)

HDR

(Automatic Exposure Bracketing). DSLR cameras and some compact digital cameras
offer this feature. It enables you to automatically take three or more exposures in a
row: one at the proper exposure, one or more underexposed, and one or more over-
exposed.

In Aperture Priority mode, you select the aperture and the camera determines the
correct shutter speed for the available light. The shutter speed also depends on I1SO
sensitivity. This is the right mode for shooting bracketed shots for HDR (refer to Sec-
tion 1 for more information).

Bits represent digital data in computers. Digital Images are made of bits. A bit depth
corresponds to 2A(Bit Depth) levels (e.g. 256 for 8-bit).

The number of bits a file type uses to represent a pixel's color at a given location in an
image.

A group of photos taken with the Automatic Exposure Bracketing function of a cam-
era, resulting in photos of the same scene taken with different exposures.

As the lens focuses different wavelengths slightly differently, chromatic aberration
occurs. For example, the purple fringing you often find around edges (leaves in front
of a bright sky).

Another way to describe the dynamic range of a scene. The ratio between the darkest
and brightest areas.

Digital Single Lens Reflex camera.

In the context of photography, the total range of light intensity in a scene, from the
deepest shadows to the brightest highlights.

The Exchangeable Image File header contains information about the image, the cam-
era, location, date and time and camera settings.

The amount of light that enters a camera for the length of time the shutter is open.
Exposure depends on aperture and shutter speed, as well as the camera’s sensitiv-
ity to light (controlled by the 1SO). "Exposure" is also shorthand for a photograph or
frame (a frame of film).

Combination of bracketed photos in such a way that highlight details are taken from
the underexposed photos and shadow details from the overexposed ones.

A measure of exposure which is the equivalent of a stop. In the absolute sense, EV

is defined as the exposure from a photo taken at 1 second, f/1, and ISO 100. In the
relative sense, the correct exposure is normally 0 EV and any deviation is measured in
positive or negative EV from that mark.

High Dynamic Range.
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HDR Image

Histogram

JPEG

Noise

Pixel

PPI

RAW File

TIFF

Tone Mapping

Strictly speaking, an HDR image is an intermediary image with 32 bits per color chan-
nel (96 bits per pixel). An HDR image is the result of merging photos of the same
scene taken under different exposure settings and stored in special HDR image
format. The 32-bit intermediary HDR image must be processed with tone mapping
for proper display on standard monitors and prints. It has become very common to
define "HDR image" as the result of processing the 32-bit HDR image with tone map-
ping, i.e. the tone mapped output, but this is not technically correct.

Histograms represent brightness distribution in digital images. They help evaluate
correct exposure. The y-axis represents the amount of pixels and the x-axis represents
the brightness value.

A common image file format with two primary strengths - a relatively small file size
and universal compatibility. JPEGs use a lossy compression scheme and should not
be edited and re-saved.

Statistical variations inherent in the sensor system cause noise. Noise is always pres-
ent, but higher sensitivities and smaller sensors usually generate more noise.

Digital pictures consist of pixels, the smallest units. Each pixel has a color that can be
represented by 8 or 16 bits or as a floating-point number (32bit HDR).

Pixels per Inch. Can be used to describe the actual pixels per inch of a print. Often
confused with DPI (Dots per Inch), used by color printers to print an image.

A file containing the raw data from the camera sensor. RAW files do not have a color
profile or other stylistic preferences permanently applied.

A comprehensive image format that offers lossless compression schemes for smaller
file sizes with higher quality. This format is suitable for editing and printing but not
publishing on the Web.

Processing a 32-bit HDR image into an image that can be properly viewed on
monitors and in prints.
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Resources
FAQ

You can find more tips, techniques, and regularly updated information in the Photomatix FAQ on the HDRsoft
website at http://www.hdrsoft.com/support/fag _photomatix.html.

Learn More

Additionally, the resources page at http://www.hdrsoft.com/resources/ lists Internet tutorials, book and
DVDs on the subject of HDR photography that, along with your own experience, will help deepen your
understanding of it.
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